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Author Questionnaire
1. Microscopy: Does your protocol require the use of a dissecting or stereomicroscope for performing a complex dissection, microinjection technique, or something similar?  Enter Yes or No.  
If Yes, can you record movies/images using your own microscope camera?
Enter Yes or No.  
If your protocol involves microscopy but you are not able to record movies/images with your microscope camera, JoVE will need to use our scope kit. 
If your microscope does not have a camera port, the scope kit will be attached to one of the eyepieces and you will have to perform the procedure using one eye.
Enter make and model of microscope.
If a dissection or stereo microscope is required for your protocol, please list all shots from the script that will be visualized using the microscope (shots are indicated with the 3-digit numbers, like 2.1.1, 2.1.2, etc.).
Click here to list microscope shots, using the shot numbers from the protocol section of the video script.

2. Software: Does the part of your protocol being filmed include step-by-step descriptions of software usage?  Enter Yes or No.
If Yes, we will need you to record using screen recording software.
We recommend using the screen capture program OBS. JoVE’s tutorial for using OBS Studio is provided at this link: https://review.jove.com/v/5848/screen-capture-instructions-for-authors?status=a7854k
As these files are necessary for finalizing your script, please upload all screen-captured video files to your project page as soon as possible.

3. Filming location: Will the filming need to take place in multiple locations?   Enter Yes or No.
If Yes, how far apart are the locations? Click to enter distance between locations.

To ensure that your script can be filmed in one day, the protocol sections are cumulatively restricted to 55 shots (shots are the 3-digit numbers like 2.1.1, 2.1.2…etc)

Current Protocol Length
Number of Steps:  xx
Number of Shots:  24 

Introduction
Videographer: Obtain headshots for all authors available at the filming location. 

Answers to these questions will become interview statements that you will deliver on camera.
· Answer the 1st REQUIRED question and at least 2 other questions (1.2 – 1.10) below. Up to 5 interview statements will be included in the video.
· Enter the full name of the author who will deliver the statement.
· If possible, each author should deliver no more than two statements.
· Answer in full sentences, in a style suitable for being spoken aloud. 
· Limit the length of each statement to 30 words or fewer.
· Answers will be edited for length, clarity, and consistency with journal style guidelines.

REQUIRED: What is the scope of your research? What questions are you trying to answer? 
1.1. Enter author name.: Click here to answer question. Please write in a style that you will be comfortable memorizing and speaking aloud. Limit length to 30 or fewer words.

What are the most recent developments in your field of research?
1.2. Enter author name: Click here to answer question. Please write in a style that you will be comfortable memorizing and speaking aloud. Limit length to 30 or fewer words.
What technologies are currently used to advance research in your field?
1.3. Enter author name: Click here to answer question. Please write in a style that you will be comfortable memorizing and speaking aloud. Limit length to 30 or fewer words.
What are the current experimental challenges?
1.4. Enter author name: Click here to answer question. Please write in a style that you will be comfortable memorizing and speaking aloud. Limit length to 30 or fewer words.

What significant findings have you established in your field?
1.5. Enter author name: Click here if you choose this question. Please write in a style that you will be comfortable memorizing and speaking aloud. Limit length to 30 or fewer words.

What research gap are you addressing with your protocol?
1.6. Enter author name: Click here if you choose this question. Please write in a style that you will be comfortable memorizing and speaking aloud. Limit length to 30 or fewer words.

What advantage does your protocol offer compared to other techniques?
1.7. Enter author name: Click here if you choose this question. Please write in a style that you will be comfortable memorizing and speaking aloud. Limit length to 30 or fewer words.
How will your findings advance research in your field?
1.8. Enter author name: Click here if you choose this question. Please write in a style that you will be comfortable memorizing and speaking aloud. Limit length to 30 or fewer words.
What new scientific questions have your results paved the way for?
1.9. Enter author name: Click here if you choose this question. Please write in a style that you will be comfortable memorizing and speaking aloud. Limit length to 30 or fewer words.
What research questions will your laboratory focus on in the future?
1.10. Enter author name: Click here if you choose this question. Please write in a style that you will be comfortable memorizing and speaking aloud. Limit length to 30 or fewer words.


Videographer: Obtain headshots for all authors available at the filming location.

Testimonial Questions (OPTIONAL): 

Answers to these questions will not appear in the video but may be featured in our journal's promotional materials.
· Enter the full name of the author who will deliver the statement.
· Answer in full sentences, in a style suitable for being spoken aloud. 
· Answers will be mildly edited for clarity.
· Limit the length of each statement to 50 words or fewer.


How do you think publishing with JoVE will enhance the visibility and impact of your research?
1.11. Enter author name: Click here if you choose this question. Please write in a style that you will be comfortable memorizing and speaking aloud. Limit length to 50 or fewer words.
Can you share a specific success story or benefit you’ve experienced—or expect to experience—after using or publishing with JoVE? (This could include increased collaborations, citations, funding opportunities, streamlined lab procedures, reduced training time, cost savings in the lab, or improved lab productivity.)
1.12. Enter author name: Click here if you choose this question. Please write in a style that you will be comfortable memorizing and speaking aloud. Limit length to 50 or fewer words.


Ethics Title Card
This research has been approved by the Ethics Committee of Beijing University of Chinese Medicine and its Third Affiliated Hospital 


Protocol  
[bookmark: _Hlk188263998]Please review this section to make sure that it accurately describes your protocol. Use Track Changes when making edits or revisions.
· The two-digit steps (e.g., 2.1., 2.2.) are the narration.  JoVE is responsible for the narration of the protocol and results.
· Red italics are pronunciation guides indicating how the word will be spoken. 
· Filming should take no more than 10 minutes per step. If a step takes more than 10 minutes, prepare the product for that step in advance.
· The three-digit shots (e.g., 2.1.1., 2.2.2.) are the actions that the videographer will capture. 

2. Data Analysis to Distinguish Patients with COPD from those with RTI
Demonstrator: Click here to enter name of demonstrator(s) 

If the same person is the demonstrator throughout, mention them once here and remove the "Demonstrator" field from the other sections; if the demonstrator changes, retain the field in the respective sections.

2.1. After assembling the vocal feature indicator database, open SPSS (S-P-S-S) and load the appropriate data file [1]. From the menu bar, select Analyze, then choose Nonparametric Tests, followed by Legacy Dialogs, and click on 2 Independent Samples [2].
2.1.1. WIDE: Talent seated at a computer, opening SPSS and loading the dataset file.
2.1.2. SCREEN: Show the cursor navigating to Analyze > Nonparametric Tests > Legacy Dialogs > 2 Independent Samples on the SPSS menu bar.
Authors: Please create screen capture videos of the shots labeled as SCREEN, create a screenshot summary, and upload the files to your project page as soon as possible: https://review.jove.com/files_upload.php?src=20807758


2.2. In the pop-up dialog box, select the observed variables to be compared under the Test Variable List section [1]. Then, under Grouping Variable, select the variable that will be used for grouping [2]. Click the Define Groups button and enter the identifiers for the two groups in the pop-up window [3].
2.2.1. SCREEN: Show the 2 Independent Samples dialog box with the user selecting variables under the Test Variable List field.
2.2.2. SCREEN: User selecting the appropriate grouping variable in the Grouping Variable field.
2.2.3. SCREEN: Cursor clicking on Define Groups, entering group values in the input fields, and confirming.

2.3. Under Test Type, select the Mann-Whitney U test [1]. Click OK to run the test and allow SPSS to automatically generate the output [2].
2.3.1. SCREEN: Cursor checking the box or selecting the Mann-Whitney U test from the available test options.
2.3.2. SCREEN: User clicking OK, followed by the appearance of SPSS output with test results.

2.4. For principal component analysis, ensure that the data is collated, saved in Excel or CSV format, and imported into SPSS version 20.0 [1]. To open the file, select File, then choose Open, followed by Data, and select the appropriate file [2].
2.4.1. SCREEN:: Talent shows a CSV or Excel file with the data and opening SPSS 20.0.
2.4.2. SCREEN: Cursor navigating through File > Open > Data and selecting the saved data file. 

2.5. To initiate Principal Component Analysis, click Analyze, then choose Dimension Reduction, and select Factor [2-TXT].
2.5.1. SCREEN: Cursor navigating through Analyze > Dimension Reduction > Factor.. TXT: Ensure missing values, outliers, and variable standardization are handled

2.6. In the dialog box, add all continuous variables used in Principal Component Analysis into the Variables field [1]. Click the Extraction button and select the Principal Components method as the extraction technique [2].
2.6.1. SCREEN: Show the user selecting and moving multiple continuous variables into the Variables field of the dialog box.
2.6.2. SCREEN: Cursor clicking on Extraction, then choosing Principal Components method from the available options.

2.7. Select Eigenvalues greater than 1 as the criterion for retaining principal components [1].
2.7.1. SCREEN: Cursor selecting the option Eigenvalues greater than 1 under the extraction criteria.

2.8. Select the rotation method and click Rotation to choose either Varimax or Promax [1].
2.8.1. SCREEN: Cursor clicking on Rotation in the factor analysis window.  Display the selection of Varimax or Promax from the list of rotation methods.

2.9. Under Options, check both Scree plot and Coefficient matrix to include the gravel diagram and the matrix of coefficients in the output for evaluating retained variance [1]. After completing all the settings, click OK to execute the analysis and allow SPSS to generate the output [2].
2.9.1. SCREEN: Cursor opening the Options dialog and selecting checkboxes for Scree plot and Coefficient matrix.
2.9.2. SCREEN: Cursor clicking the OK button and then showing the SPSS output window displaying results from the Principal Component Analysis.

2.10. Interpret the principal component loading matrix to assess the relationship between the principal components and the original variables [1]. Identify variables with higher loading values, as these contribute more significantly to component changes [2].
2.10.1. SCREEN: Highlight the component loading matrix in the SPSS output and point out specific variable loadings.
2.10.2. SCREEN: Zoom in on variables with high load values, showing their strong influence on specific components.

2.11. Use the Total Variance Explained table to evaluate how much variance each principal component accounts for [1]. Identify the principal components with large variance proportions, as they typically capture most of the data variation [2].
2.11.1. SCREEN: Show the Total Variance Explained table and highlight the eigenvalues and variance percentages.
2.11.2. SCREEN: Indicate principal components with large variance proportions.

2.12. Refer to the scree plot to determine which components to retain [1]. Locate the inflection point and keep all components to the left of this point [2].
2.12.1. SCREEN: Display the scree plot from SPSS output with cursor identifying the inflection point.
2.12.2. SCREEN: Highlight the retained components positioned to the left of the inflection point.

2.13. If principal component scores are required, check Save as variables before running the analysis [1]. SPSS will add the scores for each sample as new variables in the dataset [2].
2.13.1. SCREEN: Cursor selecting the checkbox labeled Save as variables before executing the analysis.
2.13.2. SCREEN: SPSS data view showing newly added columns with principal component scores.




Results
Please review this section to make sure that it accurately reflects your findings.
· This section will not be recorded by the videographer. It only includes the figures/tables from your manuscript (called LAB MEDIA). 
· Use Track Changes when making edits or revisions. Ensure the voiceover length is below 200 words. Current word count: 160.
· Please note that the video cannot include voiceover without an accompanying visual.

3. Results 

3.1. Principal component analysis identified 6 major components, which together accounted for 76.8% of the total variance [1]. The logistic regression model demonstrated stable performance across 3 validation folds, with AUC values of 0.71, 0.74, and 0.88, yielding a mean AUC of 0.77 [2].
3.1.1. LAB MEDIA: Figure 1. 
3.1.2. LAB MEDIA: Figure 2. Video editor: Highlight the individual ROC curves for folds 1, 2, and 3, showing their curve shapes and AUC values.
3.2. In contrast, the random forest model exhibited greater variability, with fold AUC scores of 0.69, 0.52, and 0.83, and a lower mean AUC of 0.68 [1].
3.2.1. LAB MEDIA: Figure 3. Video editor: Highlight the individual ROC curves for folds 1, 2, and 3, showing the inconsistent curve shapes and corresponding AUC values.
3.3. The logistic regression model achieved 100% correct predictions for COPD and 6 out of 7 correct for respiratory tract infections, as shown in the confusion matrix, indicating high classification accuracy [1].
3.3.1. LAB MEDIA: Figure 4. Video editor: Highlight the bottom-right cell showing 6 correct predictions for RTI.
3.4. The random forest model misclassified 1 COPD and 2 respiratory tract infection cases, resulting in lower classification accuracy compared to the logistic regression model [1].
3.4.1. LAB MEDIA: Figure 5. 
3.5. On the test dataset, the logistic regression model yielded excellent classification performance, achieving an AUC value of 0.95 [1]. The random forest model showed lower test performance with an AUC value of 0.76 [2].
3.5.1. LAB MEDIA: Figure 6. Video editor: Highlight the orange ROC curve and the shaded region underneath it.
3.5.2. LAB MEDIA: Figure 7. Video editor: Highlight the orange ROC curve and the shaded region underneath it.
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